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UPFRONT INSTALLATION AND
DEPLOYMENT GUIDE

Overview
1‘-_% The UpFront Installation and Deployment
Guide assists with the integration of

UpFront into your company’s job planning processes.
The UpFront Installation and Deployment Guide
provides:

* A central place for gathering information about
your company’s presses and finishing equipment.
This information can be obtained from equipment
manuals and/or operators. It is then entered into
UpFront’s central database. UpFront constantly
checks the jobs you are planning against the
database, which greatly reduces the risk of
planning a job your equipment cannot print or
bind.

* A central place for gathering information about
ScenicSoft Preps®. If your company uses Preps for
electronic imposition, you may wish to export
Preps templates after planning your jobs in
UpFront. To do this, you need to gather
information about Preps templates from the Preps
operator(s). This includes information about
custom mark names and other template settings.

* Instructions for installing UpFront.

e Sample deployment scenarios, including both
single-user and multi-user implementations.
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GATHERING EQUIPMENT INFORMATION

Overview
‘%. Before installing UpFront, take some time
- . L
to gather the information listed on the next

few pages regarding each press and each piece of
finishing equipment (saddle-stitchers or perfect
binders) for which you will be planning jobs. User-
added finishing equipment may be single machines,
or processes produced by the combined requirements
of several machines. This includes presses and
finishing equipment at your shop, as well as any
equipment used to produce your jobs off site, such as
a trade printer or bindery. This information can be
obtained from equipment manuals and/or those who
operate the equipment. Make as many copies as you
need of the next few pages to gather the necessary
information. Refer to Chapter 5, “Populating the
UpFront Central Databases,” for instructions for
entering the information into UpFront.

For questions about UpFront terminology, refer to
pages 9 - 19 of this guide.

Miscellaneous Strategies

 If your shop has two or more of the same press, or
presses that are the same with the exception of the
number of ink units, it may not be necessary to
enter each instance of a similar press. For ex-
ample, a 2-color press may have all the same
specifications as a 4-color press (except for the
number of ink units), in which case you may
decide to create only one press in the database.
The Press Layouts created in UpFront could then
run on either press. The same principle applies to
finishing equipment.

e Occasionally a job may require gripping into the
printable area of the job. After the presses have
been added to the UpFront Presses database, you
may wish to create a duplicate press that allows for
zero grip, then name the press to indicate this. For
example, “4-Color with 0 Grip.”

e If one of your shop’s presses has in-line finishing
equipment, such as an in-line saddle-stitcher, make
a separate entry for it in the Finishing Equipment
database and name it accordingly.

2 SCENICSOFT
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SHEETFED PRESSES

(Make one copy for each sheetfed press)

Press Name:

Sheet Size

Minimum Sheet Size Around Cylinder:

Minimum Sheet Size Across Cylinder:

Maximum Sheet Size Around Cylinder:

Maximum Sheet Size Across Cylinder:

Image Area and Plate Size
Maximum Image Area Around Cylinder:

Maximum Image Area Across Cylinder:

Plate Size Around Cylinder:

Plate Size Across Cylinder:

Grip and Other Paper Edges

Minimum Paper Grip:

Plate Edge to Press Sheet Edge:

Absolute Minimum Plate Edge To Trim:

Minimum Back Edge Paper:

Minimum Side Edge Paper:

Perfects
Perfects: Yes No

Minimum Sheet Size Around Cylinder when Perfecting:

Minimum Sheet Size Across Cylinder when Perfecting:

Preps
Distance from Press Sheet Edge to Punch Center:







SCENICSOFT

UpFr(mF
!

WEB PRESSES

(Make one copy for each web press)

Press Name:
Sheet Size
Around Cylinder Cut-Off 1: +/- (for web tolerance)
Around Cylinder Cut-Off 2: +/- (for web tolerance)

Minimum Roll Width:

Maximum Roll Width:

Image Area and Plate Size

Maximum Image Area Around Cylinder:

Maximum Image Area Across Cylinder:

Plate Size Around Cylinder:

Plate Size Across Cylinder:

Grip and Other Paper Edges

Minimum Paper Grip:

Plate Edge to Press Sheet Edge:

Absolute Minimum Plate Edge To Trim:

Minimum Back Edge Paper:

Minimum Side Edge Paper:

Webs

Number Of Webs: (UpFront currently supports a maximum of 3 webs)

Preps

Distance from Press Sheet Edge to Punch Center:
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FINISHING EQUIPMENT
Page 1 of 2

(Make one copy for each piece of finishing equipment or multiple-machine workflow)

Finishing Equipment Name:

Binding Method: Saddle Stitched Notch Bound Perfect Bound Smyth Sewn Cut / Folded

Head Trim
Minimum Head Trim:

Maximum Head Trim:

Default Head Trim:

Extra at Cover Head:

Foot Trim
Minimum Foot Trim:

Maximum Foot Trim:

Default Foot Trim:

Extra at Cover Foot:

Face Trim
Minimum Face Trim:

Maximum Face Trim:

Default Face Trim:

Front Lip

Minimum Front Lip:

Maximum Front Lip:

Default Front Lip:
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FINISHING EQUIPMENT
Page 2 of 2

Back Lip
Minimum Back Lip:

Maximum Back Lip:

Default Back Lip:

Trim Size
Finished Trim Size Minimum Height:

Finished Trim Size Minimum Width:

Finished Trim Size Maximum Height*:

Finished Trim Size Maximum Width*:

Untrimmed Size
Untrimmed Section Minimum Height:

Untrimmed Section Minimum Width:

Untrimmed Section Maximum Height:

Untrimmed Section Maximum Height At Absolute Maximum Width:

Untrimmed Section Maximum Width:

Untrimmed Section Maximum Width At Absolute Maximum Height:

Assorted
Spine Allowance:

Offcut:

Saddle-stitched: Smaller sections on inside or outside?

Notch-bound, Perfect-bound, Smyth-sewn: Insert smaller sections towards the front or the back?

No Image First and Last Text Pages:

No Image Inside Cover:

Section ID Either Side of Spine:

*Values determined by UpFront formula. See page 13 in Finishing Equipment Terminology for details.
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FINISHING EQUIPMENT TERMINOLOGY

& Finishing Equipment x|
L | /| % J 4 | Head Trim
Add MNew Edit Delete AEphy :
[Saddie Stiched =] e Minimum: The finishing equipment’s minimum
ISampIe Bindery Lj head trlm
Backlip |  TimSkze | Unkimmed Size * Maximum: The finishing equipment’s maximum
Azzorted I [Criagram arks I Created .
Head Trim l Foat Trim I Face Trirmn l Front Lip head trim
gl e Default: The finishing equipment’s default or

Mirirnuirn: {01125

P asimur:

Drefault: ir__-

Extra at Cover Head: |1/

shop-preferred head trim
Extra at Cover Head: The finishing equipment’s
default amount of extra paper to add. For glued

spine binding methods, extra paper is usually
desirable at the head of the cover.

Foot Trim
e Minimum: The finishing equipment’s minimum

& Finishing Equipment x| foot trim

4 ; b v . . . . s .
Al || IEJ i I : *  Maximum: The finishing equipment’s maximum
[Saddle Stitched =] foot trim
| Sample Bindery = * Default: The finishing equipment’s default or
Back Lip I Trim Size I Untirmed Size shop-preferred foot trim
Azzorted I Driagram karks I Created L .
HeadTrm  FostTin | FaceTim | FiontLp e Extra at Cover Foot: The finishing equipment’s
FasiD default amount of extra paper to add. For glued
Miriirnurm: {01 125

spine binding methods, extra paper is usually

b asirnur: i__f—_-
Crefault: !Ijl_-f.
Extraat Cover Foot: !Ijl

desirable at the foot of the cover.

Face Trim
e Minimum: The finishing equipment’s minimum

face trim

e Maximum: The finishing equipment’s maximum

face trim

& Finishing Equipment x|

e Default: The finishing equipment’s default or

ik * v .
Aidd New Efit Delete fpoly | ¢ shop-preferred face trim
|5addle Stitched |
ISampIe Bindery ;j
Back Lip I Trim Size | Untrimmed Size
Aszoted I Diagram Marks I Created
Head Trirm I Foat Trim Face Trim ] Front Lip
Face Trim
Mirirnur: {0125

I asimir:

Drefault |0 25

LCloze
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Untrimmed Size
e Minimum Height: The finishing equipment’s

minimum untrimmed section height

Minimum Width: The finishing equipment’s
minimum untrimmed section width

Maximum Height: The finishing equipment’s
absolute maximum untrimmed section height
Maximum Height at Max Width: The finishing
equipment’s maximum untrimmed section height
if the section is the maximum untrimmed width
possible. With some kinds of notch or perfect-
binding machines, when an untrimmed section’s
width approaches the maximum untrimmed
section width, the section cannot be the maximum
height. For these machines, you specify the height
of an untrimmed section if the section width is the
maximum width possible. For normal saddle-
stitching machines, or for any finishing machine
that can bind a job that is the maximum height and
width possible, enter the maximum untrimmed
section height.

Maximum Width: The finishing equipment’s
absolute maximum untrimmed section width
Maximum Width at Max Height: The finishing
equipment’s maximum untrimmed section width if the
section is the maximum untrimmed height possible

£ Finishing Equipment P x|

T & x X
Add MNew Edit Delete i Cancel
| 5addle Stitched |
| Sample Bindery _:j
Aszorted ] [Driagram karks I Created ]
Head Trim 1 Faot Trim 1 Face Trim 1 Front Lip 1
Back Lip ] Trim Size Untrimmed Size

- Untiimmed Section Size
Minimurm Height: l'—“

Minmumwidthc [1

t asimurm Height

M asirurn Height at M wdidth: | 1

I & dth: 1_____‘

I awirnurn Yfidth at bax Height: !’—-

LClose
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& Finishing Equipment i x|
aF > b4
Add MNew Edit Delete Aoy Caricel
|5addle Stitched =l
ISampIe Bindery _:j
Head Trim ] Foat Trim ] Face Trirn ] Front Lip ]
Back Lip 1 Trim Size 1 Untrimmed Size ]
Assorted ] Diagram Marks | Created |
Azzorted Propertties ——
Spine Allowance: ]iﬁ:
Offcut: i

Default Equipment: [= St to Default

Binding Sequence Rules
& Smaller Sections Outside

™ Larger Sections Outzide

Lloze

Chapter 1 - Gathering Equipment Information

& Finishing Equipment x|
ap i * X
Add Mew Edit Delete Apply Canicel
iNUlCh Eound j
I Sample Bindery _:1
Head Trim ] Fat Trim ] Fate Trirn ] Front Lip ]
Back Lip | Trim Size 1 Untrirnmed Size ]
Aszortad I Driagram ktarks ] Created ]
Azzorted Properties - — 1
Spine Allowance: ji:
Oifficut: i

Default Equipment: [ Set to Default

Binding Sequence Rules
% Inzert Smaller Sections Towards Front

" Inzert Smaller Sections Tawards Back

Lloze

Assorted

Assorted Properties

* Spine Allowance: This setting is the finishing
equipment’s spine allowance measurement for text
sections to compensate for spine grind-off. For
example, saddle-stitched finishing has a spine
allowance of 0, but perfect-binding can have a
.25" spine allowance if the sections require .125"
grind-off (the .25" spine folded in half creates the
.125" of grind-off area). These perfect-bound text
sections are not to be confused with glued spine
covers that also require a spine allowance.

» Offcut: Used only for cut-and-folded finishing
methods and gives a default value for all offcut
areas surrounding the section.

e Default Equipment: Each Finishing Method
(saddle stitched, notch bound, perfect bound, smyth
sewn, cut/folded) must have at least one piece of
finishing equipment entered into the database under
the Finishing Equipment list. Additionally, one
piece of finishing equipment must be designated as
the default selection for each of the methods listed
under the Finishing Method list. You cannot delete
the Sample Bindery equipment that comes pre-
loaded into the database for each binding method,
but you can set any additional equipment added as
the required default. User-added finishing equip-
ment may be single machines, or processes
produced by the combined requirements of several
machines.

Binding Sequence Rules

* Smaller Sections Outside and Larger Sections
Outside: For saddle-stitched books, this setting
sets the default placement of the larger and smaller
sections in the Binding Section Sequence
window in Job Builder.

* Insert Smaller Sections Towards Front and
Insert Smaller Sections Towards Back: For
notch-bound, perfect-bound and smyth-sewn books,
this setting sets the default placement of the larger
and smaller sections in the Binding Section
Sequence window in Job Builder.

SCENICSOFT | ]
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Diagram Marks
e No Image First And Last Text Pages: For notch-

and perfect-bound books, a no-ink region is
usually required along the spine edge of the first
and last text pages so the side glue for the covers
adheres to the text pages. Job Builder
automatically draws a shaded region on these
pages if the width of this setting is greater than O.
Because Job Builder draws everything precisely to
scale, it is advisable to set this region to be larger
than actually required so that it appears more
obvious on the printed diagrams.

No Image Inside Cover: For glued-spine
finishing methods, a no-ink region is usually
required through the spine and on either side of the
spine for the side gluing of the cover to the text.
Job Builder automatically draws a shaded region
on the inside of glued spine covers if the width of
this setting is greater than 0. Because Job Builder
draws everything precisely to scale, it is advisable
to set this region to be larger than actually required
so that it appears more obvious on the printed
diagrams.

Section ID Either Side of Spine: For perfect
binding, a section ID, or collation mark, is often
required along the spine edge of each text section
as a visual check of the section sequence. Job
Builder can automatically draw a shaded
rectangular area on the spine of a section to the
width of this setting as a visual clue. Because Job
Builder draws everything precisely to scale, it is
advisable to set this area to be larger than actually
required so that it appears more obvious on the
printed diagrams.

& Finishing Equipment N |
ap * d X
Add Mew Edit Delete Aol Canice
| 5addie Stiched Bd|
ISampIe Bindery _:j
Head Trim ] Foat Trim ] Face Trirn ] Front Lip ]
Back Lip 1 Trim Size 1 Untrimmed Size
Assorted DiagamMatks | Cieated |

Diagram Mark Properties

Mo Image First And Last Text Pages; i{:
Ma Image Inside Cowver: ;lf
Section |0 Either Side of Spine; i‘::

Lloze
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x| Front Lip and Back Lip
ar * v .. . . ..
addnew | Edit | Delete Aoy I cance| e Minimum: The finishing equipment’s minimum
[ addle Stitched =] front or back lip
| Sample Bindery =l *  Maximum: The finishing equipment’s maximum
Back Lip I Trim Size I Untrimmed Size I front or baCk hp
Azzorted I Diiagrar karks I Created | L. . . s
HeadTrm | FostTrm | FaceTim  Frontlip e Default: The finishing equipment’s default or
enttn shop-preferred front lip or back lip
Minirntrm: i'h
Tl awimuirn: i'j! . -
Default:iljl T"m SIZ&
* Minimum Height: The finishing equipment’s
P x| minimum finished trimmed product height
<L » = ‘ *  Minimum Width: The finishing equipment’s
Add M Edit Delet Aoy .« . . . . .
. e:_ — e - minimum finished trimmed product width
addle Stitche x
. . A L . ,
T <] Maxllmum .H.elght. 'l'“he finishing equlpment S
T (R maximum finished trimmed product height. For
Head T | FootTim | FaceTim | Frontlip dimensional spine-based binding styles, UpFront
Back Lip l Trim Size I Untrimmed Size . . .
i automatically calculates this value using the
ack Lip
irirnum 125 following formula:
Mt {175 Maximum (untrimmed) section height - minimum
i head trim - minimum foot trim
e Maximum Width: The finishing equipment’s
maximum finished trimmed product width. For
dimensional spine-based binding styles, UpFront
automatically calculates this value using the
following formula:
Maximum (untrimmed) section width - minimum
- Finishiti) EQCIRIEER ES face trim - (spine allowance + 2)
o £ x v
Add Mew Edit: Delete Apohy =
[5addle Stiched =] Created
| 5ampiz Bindery = The Created tab displays information about who
fssoted | DiagamMatks | Created created the piece of finishing equipment, when it was
Head Trim I Foat Trim I Face Trim I Front Lip .
Back Lip Trim Size I Untrimmed Size last mOdlfled, and by whom.
Finished Trim Size
Mirimium Height: i-* 5 ls shing Equipment x|
Miriirurm bfidthe | 2 5 i : 7 v ‘
Add New Edit Delete ARD (
b i Hei h:l'i 4
il [5addle Stiched |
I i \v\u"'dth.i"i
SR : ISampIa Bindery Li
Head Trim I Foot Trim I Face Trim I Front Lip I
Back Lip I Trirn Size I Untrimmed Size |
Azzorted I Diagram Marks Created
Created
Created: {10/12/2007 11:26:

Created By IchnicS oft

Last Modified: {10/12/2007 11:26

Last Madified By: ichnicSoft

Llasze
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SHEETFED PRESSES TERMINOLOGY

The graphic to the right illustrates the sections of the
press sheet/plate described in each of the following
tabs.

Note: UpFront ships with several sample presses.
The values entered for these presses are intended to
be samples only. If your shop has one of these
presses, you should confirm that these values are
correct with your press operator.

Sheet Size

Minimum Sheet Size

* Around Cylinder: The press’s minimum sheet
size around the cylinder (normally the sheet’s
short edge dimension)

* Across Cylinder: The press’s minimum sheet size
across the cylinder (normally the sheet’s long edge
dimension)

Maximum Sheet Size

e Around Cylinder: The press’s maximum sheet
size around the cylinder (normally the sheet’s
short edge dimension)

e Across Cylinder: The press’s maximum sheet size
across the cylinder (normally the sheet’s long edge
dimension)

Image Area and Plate Size

Maximum Image Area

e Around Cylinder: The maximum image area that
can be printed around the cylinder on this press

e Across Cylinder: The maximum image area that
can be printed across the cylinder on this press

Plate Size

e Around Cylinder: The plate size that fits around
the cylinder

* Across Cylinder: The plate size that fits across
the cylinder

14 SCENICSOFT

<«————— Plate Size Around Cylinder——M8MMM >

Plate Size Across Cylinder

Sheet Size Across Cylinder

<«——— Sheet Size Around Cylinder——

to Punch Center

G i * K
Add Mew Edit Delete / Cancel
I Speedmaster 102 LJ
Grip and Other Paper Edges ] Ferfects
Standard Sheet Sizes ] Created ] Freps

Shest Size Image Area and Flate Size

— Mirirnurn Sheet Size

Araund Cylinder; 1 11

Acioss Cylinder; | 155

I aximum Sheet Size -
Around Cylinder: |25 275
Acmoss Cylinder; |-

x|

|
l

G ¢ * X
Add New Edit Delete . Caricel
] Speedmaster 102 lJ
Grip and Other Paper Edges ] Ferfects
Standard Sheet Sizes I Created ] Preps

Shest Size Image Area and Plate Size
- Mazimurn Image Area
Around Cylinder; {27 5625

Acrozs Cylinder;

Plate Size
Avround Cylinder: |

Acrozs Cylinder: {40 5

|
I

Lloze

Back Edge Paper
- »
g g
& m
3 2
e )
5 o]
g g
!
Plate Edge to Distance from Absolute Minimum Paper Gri
Press Sheet Edge Press Sheet Edge Plate Edge to Trim E)Gap) P



Chapter 1 - Gathering Equipment Information

Grip and Other Paper Edges

Default Grip Specifications

* Minimum Paper Grip: Whether to account for
bleed or just to keep a standard across different
presses, companies sometimes use a minimum
paper grip that is greater than the absolute mini-
mum the press can use. This measurement is the
minimum that you want this press to allow.

* Plate Edge to Press Sheet Edge: When you plan
a Press Layout in Planner with the Auto Calculate
button selected, Planner automatically adds the
paper grip to this number to calculate the film grip

x| margin—the film or plate edge to first trim
Gl x X
A Mew Edit Delete J Aply J Eance ‘ measurement.
i Speedmaster 102 LJ
Standard Sheet Sizes ] Created ] Preps ] Zeroed Cylinder Grip Spect:ﬁcations

Sheset Size ] Image Area and Flate Size ] o ..
GipandOtterPapsiEdzes | Pescts | * Absolute Minimum Plate Edge to Trim: Every

- Default Giip Specifications 4 press cylinder has a zero setting that enables the

il printing of the maximum possible image area, but

Plate Edge to Press Sheet Edge; {1 275 .
_ not all companies use these factory default

Z d Culinder Grip 5 pecificati . ..
e settings. In some cases, such as printing a poster

Abzolute Minimurn Plate Edge ta Trim { 1.875

Other Paper Edge Specifications i .
Mirimuan Back Edge Paper [T the cylinders must be set to zero, or changed from

Mirimum Side Edge Paper [T your standard cylinder setting, which requires the
plates to be gripped to the absolute minimum

measurement from plate edge to trim.

on a full sheet size with a maximum image area,

Planner constantly monitors for this type of
situation, and, if it occurs, Planner defaults back to
the film grip measurement for Absolute Mini-
mum Plate Edge to Trim instead of the grip
calculated from the Plate Edge to Press Sheet
Edge number plus the paper grip. Planner notifies
you with a status bar message when this situation
occurs.

Other Paper Edge Specifications

* Minimum Back Edge Paper and Minimum Side
Edge Paper: The minimum amount of paper
required at the specified edges for this press to be
able to print. A press that most commonly prints
on board stock may need more paper at the back
edge of a Press Layout than a press that prints on
lighter stocks. These are the most common
settings that confuse new users, so if in doubt, err
on the side of caution by entering a small or O value.
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Perfects

* Perfects: Select this check box if the press can
perfect

* Min Perfecting Sheet Around Cylinder: The
minimum sheet size around the cylinder that can
be printed on this press while in perfecting mode

* Min Perfecting Sheet Across Cylinder: The
minimum sheet size across the cylinder that can be
printed on this press while in perfecting mode

Standard Sheet Sizes

This feature has not yet been implemented in
UpFront and is not supported at this time. This tab is
not used.

Created

The Created tab displays information about when
the press entry was created in the database, who
created it, when it was last modified, and by whom.

Preps

This tab displays the Preps setting for Distance from
Press Sheet Edge to Punch Center. The setting you
provide is used for Preps templates exported by
UpFront, eliminating the need to edit the punch
distance in Preps. If your company does not use
Preps for electronic imposition, disregard this tab.
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WEB PRESSES TERMINOLOGY

The graphic to the left illustrates the sections of the
press sheet/plate described in each of the following
tabs.

Note: UpFront ships with several sample presses. The
values entered for these presses are intended to be
samples only. If your shop has one of these presses,
you should confirm that these values are correct with
your press operator.

Sheet Size

Around Cylinder Cut-Off

* Cut Off 1: The press’s cut-off specification

e Cut Off 2: Rarely, some web presses can have a
second cut-off specification. In most cases, this
specification is set the same as Cut Off 1

* +/-: In addition to the press’s cut-off specification,
a tolerance may also be set for each Cut Off

Roll Width

* Minimum: The press’s minimum roll width
(minimum across the cylinder dimension)

e Maximum: The press’s maximum roll width
(maximum across the cylinder dimension)

Image Area and Plate Size

Maximum Image Area

* Around Cylinder: The maximum image area that
can be printed around the cylinder on this press

* Across Cylinder: The maximum image area that
can be printed across the cylinder on this press

Plate Size

* Around Cylinder: The plate size that fits around
the cylinder

* Across Cylinder: The plate size that fits across
the cylinder
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Grip and Other Paper Edges

Default Grip Specifications

e Minimum Paper Grip: To account for the area of
the press blanket that cannot print on the web,
enter the minimum amount of paper grip, or “gap”
you want to allow for this press.

* Plate Edge to Press Sheet Edge: When you plan
a Press Layout in Planner with the Auto Calculate
button selected, Planner automatically adds the
paper grip to this number to calculate the film grip
margin—the film or plate edge to first trim
measurement.

Zeroed Cylinder Grip Specifications

e Absolute Minimum Plate Edge to Trim: Every
press cylinder has a zero setting that enables the
printing of the maximum possible image area, but
not all companies use these factory default
settings. In some cases, the cylinders must be set
to zero and the film/plates must be gripped to the
absolute minimum measurement from plate edge
to trim.

Planner constantly monitors for this type of
situation, and, if it occurs, Planner defaults back to
the film grip measurement for Absolute Mini-
mum Plate Edge to Trim instead of the grip
calculated from the Plate Edge to Press Sheet
Edge number plus the paper grip. Planner notifies
you with a status bar message when this situation

occurs.

Other Paper Edge Specifications

e Minimum Back Edge Paper and Minimum Side
Edge Paper: The minimum amount of paper
required at the specified edges for this press to be
able to print. These are the most common settings
that confuse new users, so if in doubt, err on the
side of caution by entering a small or 0 value.

T Vi x X
Add MNew Edit Delete oy Canicel
| Haris M1000 e
Standard Sheet Sizes ] Created ] Preps
Sheet Size ] Image Area and Plate Size
Grip and Other Faper Edges l Wiehs

- Default Grip 5 pecifications
inimum Paper Grip; {0,215
Flate Edge to Press Sheet Edge: 1 157

Zeroed Cylinder Grip Specifications -

Absolute Minimurn Plate Edge ta Trim: {15748

Other Paper Edge Specifications

Minimurn Back Edge Paper: J
Minimum Side Edge Paper 1-::

Lloze
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GATHERING PREPS INFORMATION

Overview

‘% If your company uses ScenicSoft Preps for
electronic imposition, UpFront can export

Preps template files from the jobs created in Job
Builder. This requires certain information to be
entered into UpFront detailing the Preps settings. This
information can be obtained with the help of the
Preps prepress operators. UpFront must be installed
before these settings can be entered.

Very Important: The Preps settings entered in
UpFront are specific to individual UpFront worksta-
tions. They are not stored in a central database. In
multiple-user implementations of UpFront, care
should be taken to ensure that each UpFront worksta-
tion is configured with the same Preps settings.

Entering Preps Settings

» From the Options menu in Job Builder, select
Preps Settings.

» In the Preps Settings dialog box, select the tab for
the settings you want to change.

PREPS SETTINGS TERMINOLOGY

Template
The Preps template setting is used in conjunction
with Auto Select in the Preps Signature Selection

¥ Preps Settings B S
dialog box. If there is a “partial” signature in a Preps Templete | Fress Sheet | Page Blesd | Crop Marks |
template, this setting determines where the partial Template Information -
will be placed in the Preps job when Auto Select is Plscs Patil Signatue [T Signature(s)
used to choose the signatures for the job. The default fiom [Last —v] Signature.

setting is 1 from Last. If this setting is used, the
partial signature is placed as the next-to-last signature

in the job. For example, if the partial signature is first —
in the collating order, change Place Partial Signa- ‘ Close ]

ture to 0 from First. If the Preps operator doesn’t
know this information, the desired position of partial
signatures can be obtained from the operator(s) of the
finishing equipment.
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Press Sheet

* Position Imposition on Press Sheet: If this
option is selected, the press sheet size of the
exported Preps template equals the size of the
press sheet in the UpFront Press Layout.

Note: selecting Position Imposition on Press
Sheet and using punch coordinates in Preps to
position the imposition on the plate, is the
recommended approach.

* Position Imposition on Press Plate: If this option
is selected, the press sheet size of the exported
Preps template equals the size of the press plate,
as defined in the selected press’s Image Area and

Tavalaia | Pisss Sheet!| Page Blead | S hiatis Plate Size tab in the Web Presses or Sheetfed

Fress Shest Information | Presses database.

& Pasition Imposiion on Press Sheet  Position of Side Guides: This option is typically
i Position Impozition an Press Plate

7 Preps Settings x|

used only for sheetfed presses. The Position of

Position of Side Guides: 14 From: iBgqu Lj . . . .
Side Guides setting allows the user to specify the
Length af EenterMarks:]D.S . . .
position of the side guides on the press sheet. The
Length of Fold Marks: ]D.S

- ' default is 4" from Bottom. Meaning, the center
‘ Closs ] crosshair in the side guide is positioned 4" from

the bottom edge of the press sheet. In the From
list, the relative sheet edge can be changed to
either Top, Right, or Left. If the job does not
require side guides (typical for on-demand and
web printers), in the From list, select None.

* Length of Center Marks: This option allows you
to specify the length of the center marks that print
perpendicular to the press sheet’s edge. The
Center Mark also indicates the press sheet’s
center. If the job does not require center marks,
type 0 in the Length of Center Marks box.

* Length of Fold Marks: This is a global setting
and allows you to specify the length of the fold
marks on the imposition. If you don’t want fold
marks, type 0 in the Length of Fold Marks box.
Setting the amount on a job by job basis in
UpFront is done in the Export Preps Template
File dialog box in Job Builder when saving a job.
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Page Bleeds

The Page Bleeds tab is used to specify custom bleed
margins on the Preps template pages. These amounts
are used only if the Preps operator subsequently
opens the Preps template and chooses to use the
custom amounts rather than the default bleed margin
specified in the Preps job.

Crop Marks

The Crop Marks tab is used to specify both the
distance of crop marks from the edge of the page and
the length of the crop marks. UpFront always exports
a Preps template with crop marks placed around the
outside of the imposition. If the job does not require
crop marks to be included around the pages on the
Preps template, type 0 in the Length of Mark box.

T Preps Settings

Templatel Fress Shest  Page Bleed l Crop Marksi

Page Bleed Marging

Top: ID_‘I i} Bottorm: iD.125
Left: iU,‘I 25 Right: !U,125

T Preps Settings

Template l Fresz Sheet l FPage Bleed Crop Marks I

Crop Mark:

Diistance from Page Corner: ID.25
Length of bark: !D.25

Sl | Lloge I
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Preps Marks Data 1.8 Il =]
Selected Marks Folder
Mac:Applications:Preps:Marks:
Marks
Name Width Height | Collation

barcode.eps 18.8 2.8 False =
cmykid.eps 18.8 18.8 False =
Device-Resolution-Text.eps 144.8 12.8 False
Digital-Exposure-Test.eps 365.8 34.8 False
fillcirc.eps 18.8 18.8 False
fillcros.eps 18.8 18.8 False
In-RIPF-Color-1D-188.eps 2.8 28.8 False
In-RIP-Color-10-278.eps 28.8 2.8 False
In-RIPF-Color-1D-98.eps 28.8 2.8 False
In-RIP-Color-1D.eps i2.8 28.8 False
Marys.eps 6.8 9.8 False
onlycirc.eps 9.8 9.8 False
onlycros.eps 9.8 9.8 False
opencirc.eps 168.8 18.8 False
OpPENcCros.eps 18.8 18.8 False
regmarkl.eps 18.8 18.8 False
regmarkz.eps 9.8 9.8 False
sigcolla.eps 8.8 8.8 True
sigcollb.eps 8.8 8.8 True
sigcollc.eps a.a 8.8 True |
[ Export for UpFront... | [ ]

ENTERING PREPS MARKS INFORMATION

In addition to entering information about Preps
settings, you also need to enter information about
Preps marks. The actual mark files do not need to be
accessible to UpFront. UpFront only needs to know
the exact name and size of any EPS or TIFF marks
that will be included on the Preps templates. The
information is entered into UpFront once and is
stored in a central database. UpFront uses a generic
display to show Preps marks on Layout Plans and
Press Layouts. Actual mark previews are not shown.

ScenicSoft has developed a utility, Preps Marks Data
1.0, that allows you to quickly import information
about Preps marks into UpFront 1.6, thus saving you
the time and hassle of having to manually gather and
enter this information. The utility scans the Preps
“Marks” folder and creates a file of information
describing the Preps mark file names and their
dimensions. This file is accessed when you click
Import in the Preps Template Mark Files dialog
box in UpFront. UpFront checks the validity of the
file and enters each mark file name and dimensions
into the UpFront Preps Marks database, ignoring
any that match existing file names. Currently,
UpFront 1.6 cannot import data for custom signature
collation marks, but this functionality will be
available in a future release.

The Preps Marks Data 1.0 utility is located on the
UpFront 1.6 CD, and on the ScenicSoft web site,
and is available for both Windows and Macintosh. If
you are unfamiliar with Preps, you may need to ask a
Preps operator for assistance.

Exporting a Preps Marks Data File

To export a Preps Marks data file:

» Launch Preps Marks Data 1.0.

» Click Select and navigate to the Preps “Marks”
folder.

p Select the “Marks” folder, then click Choose (or
on Windows, click OK.) Preps Marks Data parses
the “Marks” folder (and the “dupmarks” folder
inside the “Marks” folder) and displays the mark
information.
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Note: In many shops that have multiple licenses of
Preps, the “Marks” folder may be located on a
network server so that all licenses of Preps have
access to the same marks. The Preps operators know
where the “Marks” folder is located.

» Click Export for UpFront. The Save dialog box
opens.

» In the Save dialog box, type a name for the file (or
on Windows in the File name box). The file must
end with .pmd.

» Navigate to the location you wish to save the file,

_;g_‘-.“‘-' Preps Template Mark Files

qn ¢ = W
then click Save. AddMew| Edt | Delete spply | Cancel
» From the File menu, select Quit to close the |F j=lllang EEight I\’;id”‘
Preps Marks Data 1.0 dialog box. harcode.eps 7 VS jl
crpkid eps 025 0.25
colorbar. eps 0 1]
. . fllgrc. 0.5 025
Importing a Preps Marks Data File Into UpFront fiuﬁl',';?pi E R
onlycire. eps X X
» In UpFront Planner, from the Databases menu, orllycros.sps 812 EE 812 §5
select Preps Marks. EEE:E:[DC;D;S 0.25 025
. . 1. 0,25 025
» In the Preps Template Marks dialog box, click {Z_Smiikkz:ﬁi 0135 015 -
zaimark.eps X X el
Mark Files.
. ) Irnport.... LCloze
» In the Preps Template Mark Files dialog box, —l
click Import.

» In the Enter Password dialog box, type the
planner-level password, then click OK.

» Navigate to the location of the Preps Marks Data
file, highlight the file to select it, then click Open.

» The Preps Marks Data Import message window
opens telling you how many of the Preps template
mark file names were imported, and how many
were not imported because the file names already
exist in the Preps Marks database.

» Click OK.

Click Close.

» In the Preps Template Marks dialog box,
click Close.

v

The Preps marks information is now available to
UpFront.

26 SCENICSOFT



Chapter 3
UPFRONT DEPLOYMENT

SCENARIOS




UpFront - Installation and Deployment Guide

UPFRONT DEPLOYMENT SCENARIOS

Overview
Conventional planning methods, still widely
in use today, involve a planner writing folios

and notes on folded-up pieces of paper —
sometimes numerous pieces of paper — as well as
deciding how and where to print and bind a job.
UpFront fills a unique need in production planning,
in that it provides a tool to automate many of the
repetitive, time-consuming tasks that planners do
every day.

Since UpFront changes the way jobs are planned and

usually results in significant time savings, companies

understandably want to know how to integrate it into

their production environment. In this chapter, some

basic deployment scenarios are presented which can

be modified to fit the specific needs of your company.

The following questions should be considered:

e Who will be using UpFront? Estimators?
Planners? CSRs? A combination of these?

* How will UpFront affect the responsibilities of
these people?

After reading through the deployment scenarios that
follow on the next few pages, decide which scenario
will work best for your company. Install UpFront as
outlined in Chapter 4.
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°
w, Wl Scenario 1: Single-User

Main DB

ml Layouts DB
e < ml Plans DB
ml Jobs DB

UpFront -

" In this scenario, the company has one license of UpFront. It will be installed on one workstation and
used by one user at a time. The databases mar remain on the local drive, or, for automatic backup
purposes, they can be copied to a network volume and accessed by UpFront.
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o o o .
W, W, Wl Scenario 2: Multiple-Users

Main DB
Layouts DB
Plans DB
Jobs DB

In this scenario, the compan{ has multiple licenses of UpFront, each running on a separate
workstation. The Databases folder from one of the workstations should be copied to a network
volume, and each copy of UpFront should be directed to these databases. Doing this ensures that

each UpFront workstation has access to the same data.
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Scenario 3: Using UpFront on a Citrix System

Citrix
Main DB
Layouts DB
e Plans DB
" Jobs DB

Citrix is an application server system. All applications are installed and run on the Citrix server,
but are controlled from remote workstations (Windows, Mac, or Unix) via an emulation window.
Multiple licenses of UpFront can run on the server. Users can access UpFront from an unlimited
number of workstations, but simultaneous access is limited to the number of licenses. The UpFront
databases can remain in the UpFront directory - where they are installed by default - on the
Citrix server.
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INSTALLING UPFRONT

System Requirements
‘% The following system configurations are
supported for running UpFront 1.6:

e 233 MHz Pentium-based PC or better, CD drive,
parallel port or USB™ port for the hardware key
(dongle)

e Microsoft® Windows NT® 4.0 (Service Pack 6),
Windows® 2000, or Windows XP Professional

e 40 MB of hard disk space

* 64 MB of RAM available for UpFront

¢ Monitor with 800 x 600 minimum resolution;

1024 x 768 recommended; 256 colors or greater
*  Windows-compatible laser or bubble jet printer,
black only or color (UpFront requires that the
computer have a printer driver installed for the
print preview and printing mechanism to work)

Note: Instructions for installing UpFront on a Citrix
system can be found in a tech note on the ScenicSoft
web site:
http://www.scenicsoft.com/support/technotelinks/
UpFrontInstallatiTN. html

Installing the Sentinel (Parallel) Hardware Key
The Sentinel hardware key is a copy-protection
device that plugs into a parallel port on the computer.
It is a “pass-through” device. Other devices can be
connected to the port by connecting the device to the
hardware key.

In order for the Sentinel parallel hardware key to
function properly, your computer’s BIOS setting for
the parallel port must be set to Enabled and the
Mode should be set to either Compatible or ECP.

WARNING: You should turn off the computer
before connecting or disconnecting the Sentinel
hardware key. If the computer is running when
you connect or disconnect the hardware key, the
key may be damaged.

If the hardware key is not installed or loses its
programming, UpFront will not run. The hardware
key connects to any parallel port on the PC.
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The ports have female 25-pin (DB-25) connectors
and are mounted on the computer’s back panel. If
there is more than one parallel port, we recommend
connecting the hardware key to the least-used
enabled port. If you are using a parallel port on the
computer that already has a hardware key connected
to it, install ScenicSoft hardware keys closest to the
computer.

To install the Sentinel hardware key:

P Turn off the computer.

» Unplug any device currently connected to the
parallel port you wish to use.

P Plug the male connector of the hardware key (the
one with pins rather than sockets) into the port.

P Reconnect any device that was previously
connected to the port by plugging it into the
female connector on the hardware key.

P Turn on the computer.

Installing the USB iKey Hardware Key

The iKey hardware key is a copy-protection device
that plugs into a USB port on the computer. It can
also be connected to a USB hub.

WARNING: You should install UpFront 1.6
before you plug in the iKey. Doing this ensures
that the proper driver will be found when the
iKey is plugged in. During the installation, you
will be prompted to install the iKey driver. On
Windows NT and Windows 2000, the driver will
be successfully installed. On Windows XP, even
though the UpFront installer places the driver
files in the correct system locations, the iKey will
not be recognized by Windows XP until the driver
is manually installed via the Found New Hard-
ware Wizard.

Follow the instructions for installing UpFront 1.6,
then refer to Plugging in the iKey on page 37.

You should not install the iKey driver if your
computer does not have a USB port.

In order for the iKey hardware key to function
properly, your computer’s BIOS setting for the USB
port should be set to Enabled.
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UpFront 1.6 Full Install
To install UpFront 1.6:

1.
2.
3.

Exit any applications that are currently running.
Insert the UpFront CD in the CD drive.

Open the UpFront CD, then double-click
setup.exe to start the UpFront installer. If you
have not already exited all other applications,
click Cancel and exit the other applications
before proceeding, then restart the installer. Click
Next.

The License Agreement dialog box appears.
After reading the License Agreement, click I
Agree to accept, and click Next.

The Select Destination Folder dialog box
appears. Browse to the desired location. (Note:
The UpFront installer will create a folder for the
installation, or you can type the name of a new
folder.) When you have selected the installation
location, click OK, and then click Next.

The Back Up Replaced Files? dialog box opens.
The UpFront installer may replace system files as
well as installing new files, so you may want to
back up any files being replaced. Click Yes to
create backups or click No to skip this step. If you
choose to not back up the files, skip to step 8.

The Select Backup Folder dialog box opens. To
accept the suggested location for the backup
files, click Next. To choose a different backup
location, click Browse. In the Select Backup
Directory dialog box, browse to the desired
location. Select an existing folder or type the
name of a new folder. When you have selected or
named the backup location, click OK, then click
Next in the Select Backup Folder dialog box.
The Company Name dialog box opens. UpFront
prints the specified name on the imposition
document pages. Type your company name in the
box and click Next.

The Select Measurement Standard dialog box
opens. Select the measurement standard you wish
to use with UpFront, then click Next. The
installer installs the appropriate default data for
the selected measurement standard.
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10. The Select Hardware Key Support dialog box
opens. Select the driver for the type of hardware
key you have, then click Next.

11. The Ready to Install! dialog box opens. Click
Next to install UpFront. The installation begins.
Note: On certain Windows NT installations, the
Windows Installer message box appears,
alerting you that you may need to restart the
system.

If you click Yes to restart the computer now, you
need to run the UpFront 1.6 installer again to
complete the installation. If you click No, the
UpFront installation continues. After installation is
complete, you should restart the computer before
launching UpFront 1.6.

12. When the installer finishes, the Installation
Completed! dialog box opens. Click Finish.

13. Restart your computer.

Plugging in the iKey

Windows NT and 2000

To plug in the iKey:

P When the computer restarts, plug the iKey into
one of the computer’s USB ports. The Found New
Hardware dialog box opens. Windows locates the
iKey.

» Double-click UpFront Planner 1.6 or UpFront
Job Builder 1.6 on the desktop.

P The Welcome to ScenicSoft UpFront 1.6 dialog
box opens. Enter the password that came with the
iKey, then click OK.

Windows XP

To plug in the iKey:

P When the computer restarts, plug the iKey into
one of the computer’s USB ports. Windows XP
displays a Found New Hardware alert message
in the taskbar, indicating that new hardware has
been found. It is not necessary to close this.

p After a few moments, the Found New Hardware
Wizard dialog box opens. Select Install the
Software Automatically (Recommended), then
click Next.
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» The wizard searches for Rainbow Security Token,
then the Hardware Installation warning dialog
box opens. Click Continue Anyway.

» The Insert Disk dialog box opens. Click OK.

P The Files Needed dialog box opens. Click Browse.

» The Locate File dialog box opens. Browse to the
“UpFront 1.x\iKey” directory, select
“Rnbtoken.sys,” then click Open.

» In the Files Needed dialog box, click OK.
Windows copies the necessary files.

» In the Found New Hardware Wizard dialog box,
click Finish.

» Windows XP displays a Found New Hardware
alert message in the taskbar, indicating that the
hardware has been installed and is ready for use.

» Double-click UpFront Planner 1.6 or UpFront
Job Builder 1.6 on the desktop.

» The Welcome to ScenicSoft UpFront 1.6 dialog
box opens. Enter the password that came with the
iKey, then click OK.

The installation automatically places shortcuts for
UpFront Planner and UpFront Job Builder on the
desktop and in the Start menu.

Entering Your Password

The password is on the ScenicSoft Password Genera-
tor Report (a blue sheet of paper) in a sleeve attached
to the software box.

To enter the password:

» Double-click the UpFront Job Builder or
UpFront Planner shortcut icon on the desktop.

» In the Welcome to ScenicSoft UpFront 1.6 dialog
box, type the password from the blue sheet in the
Password field.

» Click OK.

P A confirmation message appears, thanking you for
licensing ScenicSoft UpFront. Click OK.
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Updating the License

You can display the dialog box whenever you need to
see the serial number or update the license. Only one
of the programs in UpFront can be open when the
license is updated. If you are updating the license
from Job Builder, first close Planner; if you are
updating the license from Planner, first close Job
Builder.

To display the Welcome to ScenicSoft UpFront 1.6
dialog box:

P From the Options menu, select Update License.
» In the UpFront License Update dialog box, click
Yes to indicate that only one program is running
and you are ready to update the license (or if you

just want to view the serial number).

P In the Welcome to ScenicSoft UpFront 1.6 dialog
box, type the password if you are updating.
-Or-
If you are just checking the serial number, skip
this step.

P Click OK if you entered a password; click Cancel
if you didn’t.

Logging In

Because UpFront is secured from unauthorized
access, when Planner or Job Builder first starts, a
Log In window appears. The install default user
name is Administrator. Because no other user names
and passwords have yet been entered into the
database, use the administrator-level password in the
password box to gain entry into the program.

When UpFront is first installed, the passwords are a
simple initial, but for security reasons they should be
changed after you install and launch UpFront. Refer
to Setting Default Passwords in the User Guide for
more for information on setting default passwords:
The passwords are:

e user level =u

e planner level = p

e administrator level = a
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To log in to UpFront:

» Double-click the UpFront Job Builder or
UpFront Planner shortcut icon on the desktop.

» In the Password box, type the administrator-level
password (the default is a) and click OK. For
users to log in using their names and passwords
instead of the administrator-level password, see
page 46 of this guide.

» The UpFront Job Builder or UpFront Planner
dialog box opens, offering options for a quick
start; however, when UpFront is first launched,
you should enter the equipment specifications
before creating any layouts or jobs. Click Cancel
and refer to Chapter 1, “Gathering Equipment
Information.”

M anme:

I.-'-‘-.dministratl:ur

Fazzword:

e

ak.
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UpFront 1.6 Update Install

When running the UpFront 1.6 update installer, your
existing UpFront databases are automatically
repaired and compacted. We recommend that you
back up your databases before running the update
installer. The UpFront 1.6 update installer converts
databases from versions 1.5.1 and earlier to the
current version.

To install the UpFront 1.6 update:

1. Exit any applications that are currently running.

2. Locate your existing UpFront databases and
make a copy of them in a secure location
(network server folder, external media, etc.). See
step 6 for an explanation.

3. Double-click Update.exe.

4. The installer starts and the Welcome dialog box
opens, reminding you to exit all other applica-
tions before continuing. If you have not already
exited all other applications, click Cancel and
exit the other applications before proceeding,
then restart the installer. Click Next.

5. The License Agreement dialog box appears.
After reading the License Agreement, click I
Agree to accept, then click Next.

6. The Database Conversion dialog box appears,
alerting you that the first time UpFront 1.6 runs,
it converts versions 1.5.1 and earlier of your
UpFront databases to the 1.6 format.

Important: Since this conversion is not reversible
and earlier versions of UpFront do not recognize
the 1.6 format, you should make a backup copy of
your UpFront databases before installing the
UpFront 1.6 update.

Click Next.

7. The Select Hardware Key Support dialog box
opens. Select the driver for the type of hardware
key you have, then click Next. Do not install the
iKey driver if the computer does not have a USB
port.

Note: wait until after you have completed the
UpFront installation before inserting the iKey.

8. The Select Destination Folder dialog box
appears. The installer locates your existing version
of UpFront. Make sure the path in the Destination
Folder box is correct, then click OK.
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9.

10.

11.

12.

13.
14.

The Make Backups? dialog box opens. The
UpFront installer may replace system files as well
as installing new files, so you may want to back
up any files being replaced. Click Yes to create
backups, or click No to skip this step and proceed
to step 11.

The Select Backup Folder dialog box opens. To
accept the suggested location for the backup files,
click OK. To choose a different backup location,
browse to the desired location. Select an existing
folder or type the name of a new folder. When you
have selected or named the backup location, click
OK.

The installation begins.

Note: On certain Windows NT installations, the
Windows Installer message box appears, alerting
you that you may need to restart the system.

If you click Yes to restart the computer now, you
need to run the UpFront 1.6 update installer again
to complete the installation. If you click No, the
UpFront installation continues. After installation is
complete, you should restart the computer before
launching UpFront 1.6. On Windows XP, the
Hardware Installation warning dialog box
opens. Click Continue Anyway.

When the UpFront installer finishes, the Update
Complete! dialog box opens. Click Finish.
Restart your computer.

If you are using an iKey hardware key, see the
instructions on page 37 for plugging in the iKey.

The Installation automatically places shortcuts for
UpFront Planner and UpFront Job Builder on the
desktop and in the Start menu, or updates those that
already exist. Your previous UpFront directory is not
renamed, but does contain your updated UpFront 1.6
program files.
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UPFRONT ACCESS LEVELS

Overview
‘% Access levels allow you to configure
= UpFront to manage the different privileges
of the program, and should not be confused with
access privileges associated with Windows NT or
Windows 2000. You may decide to assign different
levels of access to various UpFront tasks, depending

on the deployment scenario you choose. There are
four levels of user access: Anyone, User, Planner,
and Administrator. Each major task has an access
level assigned to it. Unless the access level for a
particular task is set to Anyone, UpFront prompts
the user for the appropriate password.

The access level for each task is determined by the
administrator and can be altered to best meet the
needs of your organization. Once access levels are
defined, operators of the system can be sure that the
system is protecting their activities.

Changing Privileges

A person with administrator-level access can change
the access level required for any task. In the Access
Levels dialog box, the access level for each task is
identified by the icon at the left end of the line. The
meaning of each icon is given at the bottom of the
dialog box.

To change the access level of a task or tasks:

» In Planner, from the Databases menu, select
Access Levels.

» In the Enter Password dialog box, type the
Administrator password, then click OK.

P In the Access Levels dialog box, double-click a
task for which you want to change the access level.
Each time you double-click, the access level
changes; the icon indicates which level is currently
being offered. When the icon appears for the access
level you want for this task, click Apply.

P Repeat the above step for any other tasks as
appropriate.

The UpFront administrator should also set the
password associated with each access level, and
distribute the appropriate password(s) to each user.
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ASSIGNING USER NAMES AND PASSWORDS

Overview
1‘%‘;‘. As part of configuring UpFront, the
administrator can add users to the database

to allow individuals to access UpFront. This includes
assigning user names and passwords. The user name
and password are only used to log in to UpFront (the
user name can also be printed on layout diagrams to
identify layouts. See the UpFront User Guide for
more information). Once a user gains access to
UpFront, they use the passwords assigned to the
various tasks defined in the Access Levels dialog
box.

To add a user to the database and assign a password:

» In Planner, from the Databases menu, select [Fusers x|
Users. s s ' / ‘ X I
. add Mew ElEfE Appls SritE]
» In the Enter Password dialog box, type the oo

Administrator password, then click OK. I
» In the Users dialog box, click Add New. !F' L
P In the Name box, type the name by which you

will identify the user in the database.

P In the Password box, type the password you want
to assign to that user.

» Click Apply to enter the user in the database.

P Repeat steps 3-6 for each additional user you want

to add.
» Distribute the password(s) to the appropriate
users(s).
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DATABASES

Overview
"f% Databases are where all the non-Preps user-
defined information is stored and as such

are very valuable resources. Companies should
devise their own database backup strategy and
regularly back up these databases in case of a hard-
drive crash or a power outage that could corrupt or
lose the databases.

Single-User

In this scenario, the company has one license of
UpFront. It is installed on one workstation and used
by one user at a time. When UpFront is installed, the
databases are located on the local work station in the
UpFront Databases directory. The databases may
remain on the local workstation and should be backed
up regularly. Alternatively, the “Databases” folder
may be copied to a network volume, in which case
you need to direct UpFront to use these databases. If
your company does a regular backup of your net-
work, the UpFront databases are backed up automati-
cally. Otherwise, the databases can be manually
backed up by copying the “Databases” directory to a
backup medium (CD, external disk, etc.).

To direct UpFront to a database located on a network

server:

P In Planner, from the Options menu, select
Settings.

» On the Main Database tab, click Set. Browse to
the location of the “Databases” directory on your
network, select “Main.umd,” then click Open.

P On the Plan & Layout Databases tab, under
Press Layouts, click Set. Browse to the location
of the “Databases” directory on your network,
select “Layouts.umd,” then click Open.

P On the Plan & Layout Databases tab, under
Plans, click Set. Browse to the location of the
“Databases” directory on your network, select
“Plans.umd,” then click Open.

P Launch UpFront Job Builder and follow the steps
above. Both Planner and Job Builder must be
directed to the same databases.
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» In Job Builder, you must also establish the
location of the Jobs database. On the Main
Database under Jobs, click Set. Browse to the
location of the “Databases” directory on your
network, select “jobs.ujd,” then click Open.

Note: In a single-user scenario, you may wish to set
the access level of all of these tasks to Anyone to
avoid having to enter a password each time a major
task is performed.

Multiple-Users

In this scenario, the company has multiple licenses of
UpFront, each running on a separate workstation.
When UpFront is installed, the databases are located
on the local workstations in the UpFront Databases
directory. Copy the “Databases” folder from one of
the workstations to a network volume, then direct
each copy of UpFront to these databases. Doing this
ensures that each UpFront workstation has access to
the same data. The databases should be backed up
regularly. If your company does a regular backup of
your network, the UpFront databases are backed up
automatically. Otherwise, the databases can be
manually backed up by copying the “Databases”
directory to a backup medium (CD, external disk,
etc.).

UpFront 1.6 is now available with USB hardware
keys. This new option allows you to make use of the
latest hardware that doesn’t have a parallel port on
the motherboard, and raises the maximum number of
hardware keys that can be deployed on a single
system. This is relevant for users who want to install
multiple copies of UpFront on a single Citrix server.
Technically, you can connect up to 127 individual
USB peripherals at one time to any given computer.
Due to the fact that some devices reserve USB
bandwidth, the practical maximum of devices is less
than the theoretical maximum. But with this change,
the constraint for the number of copies that can run
on a single Citrix Server will shift towards available
memory and disk space, as opposed to the number of
hardware keys that can be plugged in.
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The hardware key change is only the first step in
ScenicSoft’s quest to facilitate multiple-user configu-
rations. For now, whether or not you deploy Citrix,
we still do not recommend more than 5 simultaneous
users connecting to a single centralized database with
UpFront 1.6. While this is an artificial limit, configu-
rations with more users have not been tested and are
therefore not supported. The next release of UpFront
will explicitly focus on securing simultaneous
database transactions. Until then, we advise against
shared database installations with 5+ users.

To direct UpFront to a database located on a network

server:

» In Planner, from the Options menu, select
Settings.

» On the Main Database tab, click Set. Browse to
the location of the “Databases” directory on your
network, select “Main.umd,” then click Open.

P On the Plan & Layout Databases tab, under Press
Layouts, click Set. Browse to the location of the
“Databases” directory on your network, select
“Layouts.umd,” then click Open.

P On the Plan & Layout Databases tab, under
Plans, click Set. Browse to the location of the
“Databases” directory on your network, select
“Plans.umd,” then click Open.

» Launch UpFront Job Builder and follow the steps
above. Both Planner and Job Builder must be
directed to the same databases.

P In Job Builder, you must also establish the location
of the Jobs database. On the Main Database under
Jobs, click Set. Browse to the location of the
“Databases” directory on your network, select
“jobs.ujd,” then click Open.

Managing Database Sizes

The databases increase in size as your library of plans,
layouts, and jobs grows. We recommend limiting the
size of these databases — especially the Jobs

database — to 25MB. Refer to the “Administration”
chapter in the UpFront User Guide for instructions on
archiving databases and setting up new databases.
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Preps Settings

Very Important: The Preps settings entered in
UpFront are specific to individual UpFront worksta-
tions. They are not stored in a central database. In
multiple-user implementations of UpFront, care
should be taken to ensure that each UpFront worksta-
tion is configured with the same Preps settings.
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POPULATING THE UPFRONT CENTRAL
DATABASES

Overview
‘% Now that you have installed UpFront, enter
= the information you gathered in Chapter 1,
“Gathering Equipment Information,” into the
UpFront central databases.

Sheetfed Presses

To add a new sheetfed press to the database:

» 1In Job Planner, from the Databases menu, select
Sheetfed Presses.

» In the Sheetfed Presses dialog box, click Add
New. (Clicking Add New duplicates the selected
press.)

» In the Enter Password dialog box, type the
planner-level password, then click OK.

» Type a name for the press.

» Enter the information you gathered for the press in

each tab, then click Apply.

Web Presses

To add a new web press to the database:

» In Job Planner, from the Databases menu, select
Web Presses.

» Inthe Web Presses dialog box, click Add New.

(Clicking Add New duplicates the selected press.)

» In the Enter Password dialog box, type the
planner-level password, then click OK.
» Type a name for the press.

» Enter the information you gathered for the press in

each tab, then click Apply.

Finishing Equipment

To add new finishing equipment to the database:

» In Job Planner, from the Databases menu, select
Finishing Equipment.

» In the Finishing Equipment dialog box, click Add

New. (Clicking Add New duplicates the selected
piece of finishing equipment.)

» In the Enter Password dialog box, type the
planner-level password, then click OK.

» Type a name for the piece of finishing equipment.
» Enter the information you gathered for each piece of

finishing equipment in each tab, then click Apply.

Congratulations! You are now ready to begin using
UpFront.
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